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Read This First

If You Need Assistance

If you have any feedback or questions, support for the MSP430 device and the eZ430-Chronos is
provided by the Texas Instruments Product Information Center (PIC), the TI E2E Forum
(https://community.ti.com/forums/12.aspx), and the eZ430-Chronos wiki at www.ti.com/chronoswiki.
Contact information for the PIC can be found on the TI web site at support.ti.com. Additional
device-specific information can be found on the MSP430 web site, www.ti.com/msp430.

Related Documentation from Texas Instruments

The primary sources of MSP430 information are the device-specific data sheets and user's guides. The
most up-to-date versions of the user's guide documents available at the time of production have been
provided on the CD-ROM included with this tool. However, the most current information is found at
www.ti.com/msp430.

Information specific to the eZ430-Chronos development tool can be found at www.ti.com/chronos.

MSP430 device and IDE user's guides may be accessed on the included CD-ROM under the user's
guides section. The IDE user's guides include detailed information on setting up a project for the MSP430
using Code Composer Studio v4 (SLAU157) and the IAR Embedded Workbench (SLAU138).

FCC Warning

This equipment is intended for use in a laboratory test environment only. It generates, uses, and can
radiate radio frequency energy and has not been tested for compliance with the limits of computing
devices pursuant to subpart J of part 15 of FCC rules, which are designed to provide reasonable
protection against radio frequency interference. Operation of this equipment in other environments may
cause interference with radio communications, in which case, the user will be required to take whatever
measures may be required to correct this interference his own expense.

Export Control Regulations

This development kit is subject to the export / import control regulations of the United States per the

harmonization code: ECCN 5A002A1A TSPA. Note that it may also be subject to export

control policies of local authorities.

Patents

German utility model and patent pending.

SimpliciTI is a trademark of Texas Instruments.
All other trademarks are the property of their respective owners.
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eZ430-Chronos Overview

1.1 Overview

The eZ430-Chronos is a highly integrated, wearable wireless development system based on the CC430. It
may be used as a reference platform for watch systems, a personal display for personal area networks, or
as a wireless sensor node for remote data collection.

Based on the CC430F6137 <1 GHz RF SoC, the eZ430-Chronos is a complete featuring a 96 segment
LCD display, an integrated pressure sensor and 3-axis accelerometer for motion sensitive control. The
integrated wireless interface allows the Chronos to act as a central hub for nearby wireless sensors such
as pedometers and heart rate monitors. The eZ430-Chronos offers temperature and battery voltage
measurement and is complete with a USB-based CC1111 wireless interface to a PC.

The eZ430-Chronos watch may be disassembled to be reprogrammed with custom applications and
includes an eZ430 USB programming interface.

eZ430-Chronos Features
• Fully functional sports watch based on the CC430F6137, MSP430 with integrated <1GHz wireless

transceiver.
• Watch can be reprogrammed for custom wireless applications.
• Highly integrated watch includes on-board three-axis accelerometer, pressure sensor, temperature

sensor, battery voltage sensor.
• 96-segment LCD display driven directly by CC430
• Can be paired wirelessly with heart rate monitors, pedometers, or other devices based on RF

transceivers such as the CC430 or CC11xx series.
• Includes an eZ430-RF USB emulator that connects the Chronos to a PC for real-time in-system

programming and debugging.

Figure 1-1. eZ430-Chronos
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1.2 Kit Contents, eZ430-Chronos
• One eZ430-Chronos watch (battery included)
• One eZ430-RF USB debugging interface
• One CC1111 USB RF access point
• One mini Phillips screwdriver
• Two spare screws
• One MSP430 Development Tool CD containing documentation and development software

– eZ430-Chronos PC-Software and Source Code SLAC341
– eZ430-Chronos Development Tool User's Guide SLAU292
– eZ430- Development Tool User's Guide SLAU227
– CC430 Family User's Guide SLAU259
– Code Composer Studio v4.0.2 Core Edition SLAC063
– Code Composer Studio v4 User’s Guide for MSP430 SLAU157
– IAR Embedded Workbench KickStart SLAC050
– IAR Embedded Workbench User's Guide for MSP430 SLAU138

NOTE: For the latest software and documentation, visit www.ti.com/chronos or www.ti.com.
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Getting Started

2.1 Using the eZ430-Chronos Watch Stand Alone

For first time use, remove the eZ430-Chronos watch from box and push any button twice to wake the
watch from sleep mode (after pushing a button once, the LCD displays the same content as shown on the
box of the kit, after the second button push the watch starts full operation).

NOTE: For the next steps it is important to understand the eZ430-Chronos user concept. The top
and bottom LCD lines can be controlled individually by pushing the buttons on the left side.
The buttons on the right side are used to select or activate secondary functions. In-depth
instructions are available in Section 3.2.

Figure 1. eZ430-Chronos Watch Push Buttons Figure 2. Overview eZ430-Chronos LCD

2.1.1 Setting the time
1. Push the "*" button until the time is displayed in the top LCD line.
2. Hold "*" for 3 seconds until the time disappears and "12H" or "24H" is shown on the LCD.
3. Select 12H/24H modes by pushing the "UP" or "DOWN" buttons.
4. Press "#" to continue with the time adjustment.
5. Set the hours by pushing the "UP" or "DOWN" button.
6. Press "#" to continue with the minute adjustment.
7. Set the minutes by pushing the "UP" or "DOWN" button.
8. Press "#" to continue with the second adjustment.
9. Set the seconds by pushing the "UP" or "DOWN" button.
10. Press "*" to confirm your settings and go back to normal operation or "#" to start over with step 2.

NOTE: If no button is pushed for more than 30 seconds, the previous settings are restored.
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2.1.2 Setting the date
1. Push the "#" button until the date is displayed in the bottom LCD line.
2. Hold "#" for 3 seconds until the year flashes on the bottom LCD line.
3. Set the year by pushing the "UP" or "DOWN" button.
4. Press "#" to continue with the month adjustment.
5. Set the month by pushing the "UP" or "DOWN" button.
6. Press "#" to continue with the day adjustment.
7. Set the day by pushing the "UP" or "DOWN" button.
8. Press "*" to confirm your settings and go back to normal operation or "#" to start over with step 3.

NOTE: If no button is pushed for more than 30 seconds, the previous settings are restored.

2.1.3 Feature Overview and Menu Structure

Figure 2-3 shows all modes and secondary functions. A detailed description of the features can be found
in Section 3.2.

Figure 2-3. eZ430-Chronos Feature Overview and Menu Structure
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2.2 Install Demo Application, Drivers and Firmware
1. Download the eZ430-Chronos PC Software and Source Code Installer (SLAC341) from the

eZ430-Chronos web page at www.ti.com/chronos or open it from the included CD.
2. Unzip the archive and run Chronos-Setup.exe.
3. Respond to the prompts to install the software. During the installation a separate window opens for

driver installation. Accept the driver installation.

NOTE: The Chronos Access Point driver is not certified by Microsoft. Therefore, Windows may
generate a warning. Allow the driver installation to use the kit.

4. When installation finishes, connect the Chronos RF USB Access Point to the PC and follow the
Windows driver installation (see Section 2.3).

2.3 Using the eZ430-Chronos Watch with a PC
1. Insert the Chronos RF Access Point into a USB port on the PC.

If prompted for the driver for the TI CC1111 Low-Power RF to USB CDC Serial Port, allow Windows to
'Install the software automatically'. This can be done only if the eZ430-Chronos PC Software package
has already been installed.
For a detailed driver installation, see .

2. Open the eZ430-Chronos Control Center program. A shortcut is available on the Desktop and the Start
Menu under Programs > Texas Instruments > eZ430-Chronos > Chronos Control Center. The Control
Center provides a variety of demos. A detailed description can be found in Section 3.3. The following
sections describe only how to use the Chronos watch to control the mouse pointer on your PC and to
use it for PowerPoint control.

Figure 2-4. Chronos Control Center

13SLAU292–November 2009 Getting Started
Submit Documentation Feedback

Copyright © 2009, Texas Instruments Incorporated

http://www.ti.com/lit/zip/slac341
http://www.ti.com/chronos
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU292


Using the eZ430-Chronos Watch with a PC www.ti.com

2.3.1 Transmission of Acceleration Data and Button Pushes
1. Select " SimpliciTI™ Acc/PPT" tab.
2. Click on "Start Access Point" to start PC. The control center status line displays "Access point started.

Now start watch in ACC, PPT or synch mode" when the PC is ready
3. Select "ACC" mode in the bottom LCD line of the Chronos watch and active the data transmission by

pressing the "DOWN" button. The watch connects to the PC (this may take a few seconds) and starts
transmitting 3D acceleration values

4. Once connected, the Control Center status bar reports Receiving data from acceleration sensor and
the values according to the axis. The graphs display the acceleration data of the watch for each axis.

Figure 2-5. Chronos Control Center With Acceleration Data

2.3.1.1 PC Mouse Control
1. Click on "Mouse On (M)" to control the PC mouse pointer with the Chronos watch. Hold the watch with

its display facing up. The mouse pointer moves vertically (x-axis in Control Center) when tilting the
watch forward/backward and moves vertically (y-axis in Control Center) when tilting the watch left/right.
Mouse clicks are possible as well:

• Left single click: "*" button
• Left double click: "#" button
• Right click: "UP" button

2. Mouse control can be calibrated to set a point of zero acceleration (i.e., no pointer movement) by
selecting "Calibration (C)". It may be disabled by clicking on "Mouse Off (M)" or by pushing "M" on the
PC keyboard.

NOTE: Holding buttons (e.g., for drag and drop) is not supported.

3. Turn the demo off by pushing the "DOWN" button on the Chronos watch and clicking "Stop Access
Point" in the PC application
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2.3.1.2 PowerPoint Control

The Control Center allows the user to map button pushes on the watch into keystrokes on the PC. The
default setting is PowerPoint control, which allows switching slides forward/backward and to start the slide
show.

1. Select "SimpliciTI Acc/PPT tab.
2. Click on "Start Access Point" to start linking. The control center status line displays "Access point

started. Now start watch in ACC, PPT or synch mode" when the PC is ready
3. Select "PPt" mode in the bottom LCD line of the Chronos watch and activate the RF link by pressing

the "DOWN" button. The watch connects to the PC, this may take a moment.
4. Once connected, the Control Center status bar show when a button is pushed.
5. Open a PowerPoint presentation. Press "#" to go to presentation mode (slide show - F5), "UP" to

switch to next slide (right arrow key) and "*" (left arrow key) to switch to previous slide.

NOTE: To avoid bouncing of the watch buttons, a delay of 0.6 s between transmissions is
implemented; i.e., if a button is pressed twice within less than 0.6, it is translated into one
keystroke only.

The Chronos Control Center allows to the user to define other short cuts; e.g. to control a
music or video player. See Section 3.3.2 for details.

For troubleshooting tips, see Appendix A, Frequently Asked Questions.
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eZ430-Chronos Software

3.1 Overview

This chapter describes the software that is included in the eZ430-Chronos kit. Different projects and PC
user interfaces are available:

1. Chronos sports watch software
2. Control Center PC software
3. Chronos watch data logger
4. Data logger PC software

Many features of the eZ430-Chronos kit are based on TI's SimpliciTI™ protocol stack. However, the
Chronos watch can also be used as a heart rate monitor. For this purpose, a second ultra-low power
protocol stack called BlueRobin™ (1) is implemented on the watch and USB access point. The protocol
stacks are selected automatically, depending on which feature is used.

(1) BlueRobin is available from BM wireless at www.bmwireless.com.

3.2 Chronos Sports Watch Software

The sports watch firmware (default) provides a broad set of features. Besides basic watch functions such
as time, date, alarm and stopwatch advanced sports watch features such as an altimeter, heart rate
monitor*, calorie-*, vertical speed-* and distance information* are available. The internal accelerometer
provides acceleration data on the watch LCD and allows controlling a PC by transferring the sensor's
measurements. The watch can also be used to control PowerPoint or other PC software with its buttons.

User concept:

The different features are either available in the top or bottom LCD line.

There are three user modes available: Modes such as Time or Date,... , Secondary Functions which
allow (de-)activation of features e.g. to start or stop the stopwatch, enable/disable alarm,... and the Set
Functions which allow changing settings (setting time, date,...) or resetting the stopwatch for example
(see Figure 3-1).

• Modes: The different modes can be selected by using the button left of the corresponding LCD line.
Examples:
The "*" button allows selecting the top line mode
The "#" button allows changing the bottom line modes

• Secondary Functions: Secondary functions provide an extension to the selected mode and are
available through the button to the right of the corresponding LCD line.
Examples:
Toggling between time (HH:MM) and seconds (.SS) in time mode: push "UP" button to toggle between
modes.
Start/Stop in stopwatch mode: push "DOWN" to start or stop stopwatch

• Set Functions: Time, date and other options can be set by holding the button left of the corresponding
LCD line.
Examples:
Setting the time (shown in top LCD line): hold the "*" button to enter the time set menu.
Resetting the stopwatch (shown in bottom LCD line): hold the "#" button to reset.
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An exception to the above modes is the Keylock. It allows locking the buttons to avoid accidental
change/activation of modes (e.g., when the watch is carried in a suitcase or bag). The keylock may be
enabled/disabled by holding "#" and "DOWN" simultaneously for 3 seconds. The LCD shows "Loct" when
the keylock is active and "oPEn" when it is inactive.

Figure 3-1. eZ430-Chronos Feature Overview and Menu Structure
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3.2.1 Detailed Feature Overview - Modes using the Top LCD Line

3.2.1.1 Time Mode

Press "*" until the time mode is active (see Figure 3-1 for details).

Secondary function: Seconds. Press "UP" to activate the alternative display. To return to the HH:MM
mode, push the "UP" button again.

Set function: Setting the time.

1. Hold "*" for 3 seconds until the time disappears and "12H" or "24H" is shown on the LCD
2. Select 12H/24H modes by pushing the "UP" or "DOWN" buttons
3. Press "#" to continue with the time adjustment
4. Set the hours by pushing the "UP" or "DOWN" button
5. Press "#" to continue with the minutes adjustment
6. Set the minutes by pushing the "UP" or "DOWN" button
7. Press "#" to continue with the second adjustment
8. Set the seconds by pushing the "UP" or "DOWN" button
9. Press "*" to confirm your settings and go back to normal operation or "#" to start over with step 2

NOTE: If you do not press any button for more than 30 seconds, the previous settings are restored.

3.2.1.2 Alarm Mode

Press "*" until the alarm mode is active (see Figure 3-1 for details). The alarm mode can be
distinguished from time mode, as an alarm symbol (bell) flashes when the alarm time is displayed.

Secondary function: Alarm on/off. Press "UP" to enable/disable the alarm. The settings are confirmed
by "on" and "off" in the top LCD line. The bell icon stays on in all other modes when the alarm is
enabled and does not appear when it is disabled.

Set function: Setting the alarm time.

1. Hold "*" for 3 seconds until the alarm time hour starts to flash
2. Set the hours by pushing the "UP" or "DOWN" button
3. Press "#" to continue with the minutes adjustment
4. Set the minutes by pushing the "UP" or "DOWN" button
5. Press "*" to confirm your settings and go back to normal operation or "#" to start over with step 2

NOTE: If you do not press any button for more than 30 seconds, the previous settings are restored.
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3.2.1.3 Temperature Mode

Press "*" until the temperature alarm mode is active (see Figure 3-1 for details). The temperature can be
shown in degree Celsius or Fahrenheit. The selection depends on the time mode setting. In 12H mode,
the temperature is shown in degrees Fahrenheit, in 24H mode in degrees Celsius. The temperature is
measured in 1-second intervals. Positive temperatures are marked with a small arrow pointing up in the
upper LCD line, left of the temperature. An arrow pointing down indicated temperatures below zero.

Secondary function: None

Set function: Temperature calibration (can also calibrated from PC software in Synch mode, see
Section 3.3).

1. Hold "*" for 3 seconds until the temperature starts to flash
2. Set the temperatures by pushing the "UP" or "DOWN" button
3. Press "*" to confirm your settings

NOTE: The temperature is measured inside the watch right inside the CC430 device. When the
watch is worn, the temperature of the watch may be different due to the body heat. For
accurate temperature measurements, do not wear the watch and allow a sufficient amount of
time for the watch to adapt to the surrounding temperature.

3.2.1.4 Altimeter Mode

Press "*" until the altimeter alarm mode is active (see Figure 3-1 for details). The altitude can be shown in
metric or imperial units. In 12H time mode, the altitude is shown in imperial, in 24H time mode in metric
units. The altitude is measured only when the altimeter mode is active, and measurement happen in
intervals of 1 second.

The implementation of the altitude algorithm is done according to the VTI's application report AN33 without
any additional low-power optimizations. Therefore, the altimeter is active only in altimeter mode. In
addition, a timeout deactivates the measurements after 60 minutes. Altitudes above sea level are
indicated with a small arrow pointing up in the upper LCD line, left of the altitude. Altitudes below sea level
are indicated with a small arrow pointing down.

The altimeter algorithm is based on the air pressure and the ambient temperature. Therefore, changes in
air pressure affect the altitude accuracy. For precise measurements, the altimeter needs to be calibrated
manually upon weather changes.

NOTE: For most accurate altitude measurement, the watch needs to have ambient temperature
(i.e., should not be worn directly on the arm), as temperature is part of the altitude
measurement (see Section 3.2.1.3).

Secondary function: Re-activate altimeter after timeout

Set function: Altitude calibration

1. Hold "*" for 3 seconds until the altitude starts to flash
2. Set the altitude by pushing the "UP" or "DOWN" button
3. Press "*" to confirm your settings.
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3.2.1.5 Heart Rate Mode - RF (2)

Press "*" until the heart icon appears on the display i.e. heart rate mode is active (see Figure 3-1 for
details). When this mode is active, heart rate is shown and burned calories are determined (additional
settings need to be made for first time use, see Section 3.2.2.7). For information on how to use the chest
belt, see to the documentation included with the heart rate monitor device.

NOTE: This mode requires a heart rate monitor (chest belt) that is not included in this kit, but
available from BM Innovation, Germany (see www.bm-innovations.com/chronos). However, a
heart rate can be simulated without a chest belt by the Chronos Control Center, see
Section 3.3 for details.

Whilst all other Chronos software is based on TI's SimpliciTI protocol, the heart rate
monitoring uses BlueRobin, an ultra-low power, low data rate wireless communication
protocol from BM wireless, Germany.

(2) Additional accessory or Chronos Control Center heart rate simulation required.

Secondary function: Heart rate display on/off. Press "UP" to enable/disable the heart rate monitoring.
Once a connection is established, the heart rate is shown on the top LCD line

Set function: None

3.2.1.6 Speed Mode - RF (3)

Press "*" until the "mi/h" or "km/h" icon is shown on the display; i.e., the speed mode is active (see
Figure 3-1). Your running speed is shown on the LCD top line.

NOTE: This mode requires a heart rate monitor (chest belt) which includes an accelerometer to
determine running speed. Visit BM Innovation at www.bm-innovations.com/chronos for
available additions. However, speed can be simulated without a chest belt by the Chronos
Control Center, see Section 3.3.4 for details.

Whilst almost all other Chronos software is based on TI's SimpliciTI protocol, the speed
monitoring uses BlueRobin, an ultra-low power, low data rate wireless communication
protocol from BM Innovation.

(3) Additional accessory or Chronos Control Center heart rate simulation required.

Secondary function: None

Set function: None

3.2.1.7 Tilt Mode

Press "*" until the tilt mode is active (see Figure 3-1). The acceleration is shown in G (9.81m/s2) for all
three axes. After entering the tilt mode, the y-axis acceleration is shown by default, and the z-axis or
x-axis can be selected. Positive acceleration values are marked with a small arrow pointing up in the top
LCD line, left of the acceleration. Negative acceleration values are marked with a small arrow pointing
down.

Secondary function: Select axis. The default is y-axis, followed by z-axis and x-axis.

Set function: None
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3.2.2 Detailed Feature Overview - Modes Using the Bottom LCD Line

3.2.2.1 Date Mode

Press "*" until the date mode is active (see Figure 3-1).

Secondary function: Year. Press "DOWN" to activate the alternative display. To return to day and month,
push the "DOWN" button again.

Set function: Setting the date

1. Push the "#" button until the date is displayed in the bottom LCD line.

2. Hold "#" for 3 seconds until the year flashes on the bottom LCD line.

3. Set the year by pushing the "UP" or "DOWN" button.

4. Press "#" to continue with the month adjustment.

5. Set the month by pushing the "UP" or "DOWN" button.

6. Press "#" to continue with the day adjustment.

7. Set the day by pushing the "UP" or "DOWN" button. Press "*" to confirm your settings and go back to
normal operation or "#" to start over with step 3.

NOTE: If no key is pressed for more than 30 seconds, the previous settings are restored.

3.2.2.2 Stopwatch Mode

Press "*" until the stopwatch mode is active (see Figure 3-1). It supports up time intervals up to 19 hours,
59 minutes and 59 seconds. For the first 20 minutes, the resolution is 1/100 second, after 20 minutes the
resolution changes to 1 second.

Secondary function: Start/stop. Press "DOWN" to start or stop the stopwatch

Set function: Reset stopwatch.

Hold the "#" button until the stopwatch is set to zero

3.2.2.3 Battery Voltage Mode

Press "*" until the battery voltage is shown (see Figure 3-1). It is updated once per minute.

Secondary function: None

Set function: None

3.2.2.4 Acceleration Mode - RF

This mode requires the Chronos Control Center PC software.

Press "*" until "ACC" is shown on the LCD (see Figure 3-1). This mode provide a continuous transmission
of 3D acceleration from the watch using TI's SimpliciTI™ protocol stack. In addition, the watch transmits a
signal when the "#", "*" or "UP" buttons are pushed.

Secondary function: Start/stop transmission of acceleration data. Pushing "DOWN" starts/stops the
pairing process or stop the transmission (the Access Point on the PC has to be started first from the
Chronos Control Center (see Section 3.3.1). The RF icon on the LCD flashes when the radio is active. If
the pairing fails, it disappears. The top LCD line shows the time during the pairing and until the data
transmission is disabled.

Set function: None
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3.2.2.5 PowerPoint Mode - RF

This mode requires the Chronos Control Center PC software.

Press "*" until "PPt" is shown (see Figure 3-1). This mode allows control of a PowerPoint presentation by
translating button pushes on the watch into keystrokes of the PC keyboard. No acceleration or other data
is transmitted. The default settings are:

• "#" - Go to presentation mode (F5)
• "*" - Previous slide (Left)
• "UP" - Next slide (Right)

The Control Center allows user defined key settings (including combinations) - see Section 3.3.2.

Secondary function: Start/stop transmission of button pushes. Pushing "DOWN" starts/stops the pairing
process or stops the transmission (the Access Point on the PC must be started from the Chronos Control
Center (see Section 3.3.1). The RF icon on the LCD flashes when the radio is active; if pairing fails, the
icon disappears. The top LCD line shows the time during the pairing and until the data transmission is
disabled.

Set function: None

3.2.2.6 Sync Mode - RF

This mode requires the Chronos Control Center PC software.

Press "*" until "SYnC" is shown (see Figure 3-1). This mode allows doing a variety of watch settings
conveniently from the Chronos Control Center PC software over the air (see Section 3.3.3).

• Time settings
• Date settings
• Altitude calibration
• Temperature calibration

Secondary function: Start/stop link for Sync Mode. Pushing "DOWN" starts/stops the pairing process or
stop the link (the Access Point on the PC must be started first from the Chronos Control Center (see
Section 3.3.3). The RF icon on the LCD flashes when the radio is active. If the pairing fails, it disappears.
The top LCD line is off during the pairing and until the Sync Mode is disabled.

Set function: None

3.2.2.7 Calorie/Distance Mode - RF (4)

Press "*" until the "kcal" icon appears (see Figure 3-1). This mode shows the amount of calories that were
burned while exercising - given the optional chest belt is used and heart rate mode is active. This mode
also provides the distance (e.g. running) if an chest belt with build-in accelerometer is used. For accurate
calorie determination users need to set their sex and weight.

Secondary function: Distance. Press "DOWN" to activate the alternative display. To return to Calorie
Mode, push the "DOWN" button again.

Set function: (Re-)setting calories and setting user weight and sex.

1. Push the "#" button until the calories is displayed in the bottom LCD line
2. Hold "#" for 3 seconds until the calorie value flashes on the bottom LCD line
3. (Re-)set the calories by pushing the "UP" or "DOWN" button
4. Press "#" to continue with the user sex adjustment
5. Set the user sex by pushing the "UP" or "DOWN" button
6. Press "#" to continue with user weight adjustment
7. Set the user weight (lb in 12H time mode, kg in 24H time mode) by pushing the "UP" or "DOWN"

button
8. Press "*" to confirm your settings and go back to normal operation or "#" to start over with step 3

(4) Additional accessory or Chronos Control Center heart rate simulation required.
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NOTE: If no key is pressed for more than 30 seconds, the previous settings are restored.

3.3 Chronos Control Center PC software

The Chronos Control Center software provides several features demonstrating the wireless capabilities of
the kit. Different RF protocol stacks are automatically selected for use, depending on the function.

• 3D acceleration graph with PC mouse control
• Wireless remote control / PowerPoint control
• Time, date and calibration data synchronization tool
• Heart rate and speed simulator

NOTE: Connect the USB RF Access Point to the PC before launching the Control Center software.
For first time use, you may also have to wait until Windows has finished the access point
driver installation.

To launch the Control Center software, shortcuts are available on the Desktop and in the Start Menu
under Programs > Texas Instruments > eZ430-Chronos > Chronos Control Center.

The different features are grouped onto tabs of the Control Center windows. The tabs also indicate which
radio protocol is used.

Figure 3-2. Chronos Control Center
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3.3.1 SimpliciTI Acc/PPT Tab (Mouse and PowerPoint Control)

The SimpliciTI Acc / PPT tab support two different features. It may be used to display the acceleration
data transmitted by the watch, which can also be used to control the mouse pointer. Secondly, it may be
used to remote control the PC with user-definable shortcuts such as PowerPoint control.

Pairing watch and PC:
1. Activate the pairing on the PC by clicking on "Start Access Point". The control center status line

displays "Access point started. Now start watch in acc, ppt or sync mode" when the PC is ready
2. Select "ACC" or "PPt" on the Chronos watch by pushing the "#" button, depending on the desired

function - see detailed description in Section 3.3.1.1 or in Section 3.2.2.4.
3. Initiate pairing on the watch by pushing the "DOWN" button to activate the selected mode

After a short time, the link is established.
In "ACC" mode, the Control Center status bar shows: "Receiving data from acceleration sensor X=...
Y=... Z=...".
In "PPt" mode, the Control Center status bar reports which button is pushed ("#", "*", or "UP").
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3.3.1.1 Acc Mode

In this mode, the watch constantly transmits acceleration data to the PC. In addition, "#", "*" and "UP"
button pushes are transferred. The Control Center software shows the 3D acceleration in graphs.
Optionally, mouse control can be activated by clicking on "Mouse On (M)" or by pushing "M" on the
keyboard.

Once active, the PC mouse pointer can be controlled by tilting the watch. Hold the watch with its display
facing up. The mouse pointer moves vertically (x-axis in Control Center) when tilting the watch
forward/backward and move vertically (y-axis in Control Center) when tilting it left/right. Mouse clicks are
possible as well - see below. Mouse control can be calibrated (to set a point of zero acceleration i.e. no
pointer movement) by selecting "Calibration (C)". It may be disabled by clicking on "Mouse Off (M)" or by
pushing "M" on the PC keyboard.

• Left single click: "*" button
• Left double click: "#" button
• Right click: "UP" button

NOTE: Holding buttons (e.g., to drag and drop) is not supported.

Turn the demo off by pushing the "DOWN" button on the Chronos watch and clicking "Stop Access Point"
in the PC application.

Figure 3-3. Chronos Control Center With Acceleration Data
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3.3.1.2 PPT Mode

This mode allows using the Chronos watch as a simple PC remote control. Data is transmitted only when
either the "#", "*", or "UP" button is pushed. This information is mapped into keystrokes on the PC. The
default setting is PowerPoint control, and the buttons are mapped to:

• "#" to go to presentation mode (slide show - F5)
• "UP" to switch to next slide (right arrow key)
• "*" (left arrow key) to switch to previous slide

These settings can be changed to many other combinations; e.g., such as controlling music players or
standard Windows functions (see Section 3.3.2 for details).

Figure 3-4. Chronos Control Center With PPT Control
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3.3.2 Key Configuration Tab

This tab contains the key mapping for the Chronos watch buttons "#", "*" and "UP". Besides a single key
selection (pull down menu), also full combinations including "Shift", "Ctrl", "Alt" and "Windows" can be user
defined by ticking the corresponding option. Changes can be made whilst the "PPt" mode is active.

Examples:

• Windows
Lock PC: "L" + "Windows"

• Windows Media Player
Play/Pause song: "P" + "Ctrl"
Play next song: "F" + "Ctrl"
Play previous song: "B" + "Ctrl"

• iTunes
Play/Pause song: "Space"
Play next song: "Right" + "Shift" + "Ctrl" + "Alt"
Play previous song: "Left" + "Shift" + "Ctrl" + "Alt"

The key mapping may be changes while PPT mode is active.

Figure 3-5. Chronos Control Center Key Configuration
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3.3.3 SimpliciTI Sync

The SimpliciTI Sync tab offers the possibility setting time/date of the watch including calibration data
conveniently.

Pairing watch and PC:
1. Activate the pairing on the PC by clicking on "Start Access Point". The Control Center status line

displays "Access point started. Now start watch in ACC, PPT or synch mode" when the PC is ready
2. Select "SYnC" on the Chronos watch by pushing the "#" button.
3. Initiate pairing on the watch by pushing the "DOWN" button to activate the selected mode. After a short

time, the link is established.

Setting the watch:
1. Select metric or imperial units
2. Enter calibration data for the temperature and altitude OR read back the data from the watch by

clicking on "Read Watch"
3. Click "Copy System Time" to set watch according to read the PC system time
4. Click "Set Watch" to transfer data to watch
5. Push the "DOWN" button on watch to end connection

Figure 3-6. Chronos Control Center Sync
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3.3.4 BlueRobin Heart Rate Simulator

This mode simulates an active heart rate chest belt. Besides the heart rate it may also be used to transfer
speed and distance data.

Pairing watch and PC:
1. Activate link on the PC by clicking on "Start Transmitter". The Control Center status line displays

"Transmitting heart rate (...bpm), speed (...km/h) and distance (...m)" when the PC is transmitting data.
The heart rate may be changed by the heart rate and speed sliders or by selecting "sweep" for
automatic heart rate and speed sweeping

2. Select heart rate mode (heart symbol is shown) by pushing the "*" button - see detailed description in
Section 3.2.1.5.

3. Start receiver on watch by pushing the "UP" button
4. After a short moment, the current heart rate is displayed

Speed can be selected by pushing the "*" button
Calories can be selected by pushing the "#" button
Distance can be selected by pushing the "DOWN" button in Calorie Mode (see Section 3.2.2.7).

5. The reception may be stopped by pushing "UP" while the heart rate is shown

Figure 3-7. Chronos Control Center Heart Rate Simulator
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3.4 Chronos Watch Data Logger

Besides the sports watch software, the eZ430-Chronos kit comes with an additional software project that
turns the watch into a data logger. Heart rate, (5) temperature, and altitude can be logged in user definable
intervals of 1to 255 seconds. 8kB of Flash memory allow logging for several hours up to days, depending
on the settings. The stored data can be transferred to a PC (in CSV format) and used for further analysis.
The data logger provides fewer features compared to the sports watch software as memory is freed for
data storage. Most importantly, no Set Functions are available (i.e., the watch cannot be set or calibrated
standalone); however, this can be done conveniently by using the Chronos Data Logger PC software. The
software project for CCS can be found in C:\Program Files\Texas Instruments\eZ430-Chronos\Software
Projects\CCS\Data Logger and for IAR in C:\Program Files\Texas Instruments\eZ430-Chronos\Software
Projects\CCS\Data Logger.

Available features:

• Time, Date
• Temperature
• Altitude
• Heart rate
• Sync
• Data logger
• Battery monitoring

NOTE: No Set Functions are available in this software. All settings can be done using the Chronos
Data Logger PC software.

User concept:

The user concept and the modes remain the same as in the sports watch software except for the Set
Functions (see Section 2.1).

Figure 3-8. eZ430-Chronos Data Logger Feature Overview and Menu Structure

(5) Heart rate can be generated by Chronos Control Center. Optional heart rate monitor is available from BM innovations at
www.bm-innovations.com/chronos.
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3.4.1 Detailed Feature Overview

As all available modes remain the same in the Data Logger software, only the additions are described in
this section.

3.4.1.1 Data Logger Mode

The data logger mode can be selected by pushing the "*" button until the bottom LCD line shows "dLog". It
may be enabled/disabled by pushing the "DOWN" button. If the heart rate data logging is selected (see
next section) in data logger PC software, the heart rate monitor is automatically enabled (the RF icon
flashes until linked to a heart rate monitor). When active, the record icon on the LCD is on (see
Figure 1-1).

NOTE: Connect the USB RF Access Point to the PC before launching the Control Center software.
For first time use, you may also have to wait until Windows has finished the access point
driver installation.

To launch the Control Center software, shortcuts are available in the Start Menu under Programs >
Texas Instruments > eZ430-Chronos > Chronos Data Logger.

3.5 Data logger PC software

The eZ430-Chronos data logger PC software allows reading out logged data from the watch. It can also
be used to set and calibrate the watch, as its set modes were removed to free up as much memory as
possible for data logging.

3.5.1 SimpliciTI Data Logger

The SimpliciTI Sync tab offers the possibility setting time/date of the watch including calibration data.

Pairing watch and PC:
1. Activate the pairing on the PC by clicking on "Start Access Point". The Chronos Data Logger status

line displays "Access point started. Now start watch in acc, ppt or sync mode" when the PC is ready
2. Select "SYnC" on the Chronos watch by pushing the "#" button (see detailed description in

Section 3.3.3).
3. Initiate pairing on the watch by pushing the "DOWN" button to activate the selected mode. After a short

time, the link is established

Setting the watch:
1. Select metric or imperial units.
2. Enter calibration data for the temperature and altitude OR read back the data from the watch by

clicking on "Read Watch"
3. Specify, which data should be logged
4. Define logging time interval (1 to 255 seconds), in which data is stored
5. Click "Copy System Time" to set watch according to read the PC's system time
6. Click "Set Watch" to transfer data to watch
7. Push the "DOWN" button on watch to end connection

Reading out logged data:
1. Pair watch with PC in case not linked yet - see Pairing watch and PC above
2. Specify file name and location of log file
3. Click on "Download" to start data transfer
4. Push the "DOWN" button to stop connection when the transfer has finished.

The log file is stored in CSV format. Its content appears as one line per log. Each line starts with date,
time, heart rate, temperature, and altitude. Parameters which were not logged are set to zero (according
to settings in Chronos Data Logger PC software).
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Figure 3-9. Chronos Data Logger

3.6 eZ430-Chronos Software Projects

3.6.1 IDE Installation

To edit and download code to the CC430 device used inside the Chronos watch, Code Composer Studio
v4 Core Edition or the IAR Embedded Workbench 4.21 KickStart (or higher) must be installed.

1. Download Code Composer Studio v4 Core Edition from www.ti.com/ccs4, IAR Embedded Workbench
KickStart from www.ti.com/msp430tools or from the included CD

2. Extract the zip file and run the installation program
3. Respond to the prompts to install the IDE

NOTE: The eZ430-Chronos firmware projects are provided for both, Code Composer Studio and
IAR Embedded Workbench, and the user has the option to select the IDE of their choice.
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3.6.2 eZ430-Chronos Firmware Sources

To restore or modify the original watch projects, the source code must be installed. This happens during
the installation of the demo software package (SLAC341), which contains two different sets of examples.
Code Composer Studio v4 or the IAR Workbench can be used, regardless if code limited or not.

3.6.2.1 Using Code Composer Studio v4
1. Launch Code Composer Studio v4: Start > All Programs > Texas Instruments > Code Composer

Studio v4 > Code Composer Studio v4
2. Create new Workspace or open existing Workspace that does not yet contain Chronos projects

NOTE: Workspaces should not be located in a long path of directories as Windows only supports
path names up to 255 characters. Keep in mind that the projects contain subdirectories as
well.

3. Import Chronos Projects by clicking: Project > Import Existing CCE/CCS Eclipse Project
4. Click Browse and browse to Chronos Projects (default directory: C:\Program Files\Texas

Instruments\eZ430-Chronos\Software Projects\CCS). Confirm directory by clicking OK
5. The Chronos sports watch project appears as ez430_chronos, the Chronos data logger appears as

ez430_chronos_datalogger. Optionally, select Copy projects into workspace to create a new copy of
the projects (recommended)

6. Click Finish to finalize the project import. The projects appear in the C/C++ Projects view of CCS
7. Select the right version of the project. Each project comes with four different project settings (build

configurations), which can be selected in Project > Properties > C/C++ Build > Active Configuration >
Configuration:
868MHz with support for the full IDE (Platinum Edition - for Europe)
868MHz with support for limited IDE (Core Edition (16KB limit) - for Europe)
915MHz with support for the full IDE (Platinum Edition - for USA)
915MHz with support for limited full IDE (Core Edition (16KB limit) - for USA)

8. Go to Target > Debug Active > Debug Active Project to launch the debugger

3.6.2.2 Using IAR Embedded Workbench
1. Launch the Embedded Workbench: Start > All Programs > IAR Systems > IAR Embedded Workbench

KickStart for MSP430 4.21 > IAR Embedded Workbench
2. Open Chronos Workspace by: File > Open > Workspace...
3. Browse to to Chronos Projects (default directory: C:\Program Files\Texas

Instruments\eZ430-Chronos\Software Projects\IAR\Sports Watch or C:\Program Files\Texas
Instruments\eZ430-Chronos\Software Projects\IAR\Data Logger)

4. Select *.eww file and click Open
5. Select the right version of the project. Each project comes with four different project settings (build

configurations), which can be selected on top of the Workspace window:
868 MHz with support for the full IDE (full version - for Europe)
868 MHz with support for limited IDE (KickStart (16KB limit) - for Europe)
915 MHz with support for the full IDE (full version - for USA)
915 MHz with support for limited full IDE (KickStart (16KB limit) - for USA)

6. Go to Project > Download and Debug to launch the debugger
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Chapter 4
SLAU292–November 2009

eZ430-Chronos Hardware

4.1 Re-/Programming the eZ430-Chronos Watch: Disassembly/Assembly of the Housing

In order to program and debug code on the CC430, it needs to be connected to a PC with a JTAG
interface. The eZ430-Chronos kit includes the eZ430-RF JTAG interface for that purpose. It can only be
connected to the Chronos watch, after the watch electronic module is removed from its housing. This
chapter describes how to remove the watch electronics from the housing and how to assemble it again.

NOTE: Videos with detailed instructions can be found on www.ti.com/chronos and the CD that is
included in the kits.

4.1.1 Disassembly of Chronos Watch
1. Open screws on back of watch. Use the included Phillips screwdriver
2. Remove metal back of watch. Be careful not to damage the gasket between the watch and the metal

back
3. Lift out the watch module. Use the screwdriver as shown in Figure 4-1.

Figure 4-1. Removing Watch Module from Housing

4. Remove battery before connecting the module to the emulator. Use the screwdriver to release the clip
at the side of the battery holder (see Figure 4-2).
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Figure 4-2. Removing Watch Battery

CAUTION

(1) Always remove battery before connecting to emulator preventing the battery
from being charged.

(2) Ensure to dispose the battery properly. Keep out of the reach of children. In
case swallowed, contact physician immediately.

5. Connect to the emulator. The watch module and the USB connector need to be on the same side of
the PCB as shown in Figure 4-3. Be careful when connecting the watch module, its small plastic strips
can get stuck at components on the emulator.

Figure 4-3. Chronos Watch Module Attached to eZ430-RF Debug Interface
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NOTE: (1) Never disassemble the watch module itself.

(2) Do not bend the metal strips which are used as contacts for the buttons.

(3) Be careful when connecting the watch module to debug interface, its small plastic strips
can get stuck at components on the emulator.

4.1.2 Assembly of Chronos Watch
1. Insert the battery ("+" facing up) into watch module and close battery holder clip by pushing the open

end towards the module. In case the small clip at the end of the holder should not snap into the plastic
frame, it may has to be bent inwards slightly

2. Gently insert watch module into the housing. Insert it in parallel to the housing. Do not try to insert one
side first (see Figure 4-4). Ensure that the small metal strips of the buttons on watch module slide over
buttons of the housing (see Figure 4-5).

Figure 4-4. Chronos Watch Module Insertion into Housing
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Figure 4-5. Metal Strips of Watch Housing and Buttons of Housing

CAUTION

Be careful when inserting the watch module. Don't just push the watch module
in or tighten the screws without checking if the module is in its position. The
metal strips of the buttons may get stuck at the buttons of the watch housing. In
this case gently push the strips towards the module with the screwdriver until
they slide over the buttons (see Figure 4-6).
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Figure 4-6. Push Metal Strips Inward

3. Ensure that the gasket is in its position and replace the back with the screws again. Try using the
existing thread in the plastic housing and do not over tighten the screws!

4.2 Functional Description of the Chronos Watch

The core technology behind the eZ430-Chronos watch is the CC430F6137 microcontroller with its
integrated <1GHz radio. The CC430 also controls the LCD and its temperature sensor is used for
temperature measurement. The only other ICs on the watch PCB are pressure and acceleration sensors
and the LCD backlight driver.

Figure 4-7. eZ430-Chronos Watch Block Diagram

The PCB does not include an antenna; the metal frame of the watch module that surrounds the LCD is
used as antenna. The antenna is tuned for best performance when the watch is worn or held in hands.
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Figure 4-8. eZ430-Chronos Watch Module Front

Figure 4-9. eZ430-Chronos Watch Module Back

Table 4-1. Estimated Battery Life (Sports Watch Software)

Mode Average Current Battery Life

Shelf mode (LPM4) 2.7 µA 92.6 months

Welcome screen (LPM3) 8.9 µA 28.0 months

Time/Date 9.0 µA 27.7 months

Continuous temperature measurement 10.0 µA 25.0 months

Continuous altitude measurement 18.0 µA 13.8 months

Continuous acceleration measurement 166.0 µA 1.5 months

Continuous BlueRobin RX 40.0 µA 6.2 months

Continuous SimpliciTI PPT (no button pressed) 10.0 µA 25.0 months

Continuous SimpliciTI SYNC 0.9 mA 8 days

Continuous SimpliciTI ACC 3.7 mA 2 days

1h/day BlueRobin RX 10.3 µA 24.2 months

1h/day SimpliciTI PPT (no button pressed) 9.1 µA 25.4 months

1h/day SimpliciTI SYNC 46.1 µA 5.4 months

1h/day SimpliciTI ACC 169.9 µA 1.4 months
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4.3 Functional Description of the eZ430-Chronos RF Access Point

The RF access point is based on the CC1111F32 controller, which features an integrated USB controller
in addition to a <1-GHz radio.

NOTE: The access point is this kit comes in a small production-ready design. Therefore, it does not
include a JTAG connector. However, the bottom side provides pads that allow soldering
cables to connect the CC1111 to the CC Debugger (see schematics in Section 4.6). TI also
offers the professional CC1111EMK868-915 development kit including connectors and a
push button.

4.4 Functional Description of the eZ430-Chronos Debug Interface

The eZ430-Chronos kit includes an USB emulator that provides full programming and debugging features
using its Spy-Bi-Wire (2-wire) interface. It features a back channel MSP430 application UART that may be
used independently of a debug session.

NOTE: Despite the fact that the watch module is equipped with a 6-pin connector, there is no UART
connection from the watch to the emulator as all pins of the CC430 are already used for
other purposes.

Supported devices:

• CC430F51xx
• CC430F61xx
• MSP430F20xx
• MSP430F21x2
• MSP430F22xx
• MSP430F41x2
• MSP430F54xx
• MSP430F54xxA
• MSP430F55xx

Connector J1 on the emulator (starting on top with pin 1) (see Figure 4-10).

• UART TX (from emulator to target)
• 3.6V supply for target
• TEST/SBWTCK
• RST/SBWTDIO
• GND
• UART RX (from target to emulator)

Figure 4-10. eZ430-Chronos Debug Interface
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MSP430 Application UART:

The eZ430-Chronos emulator includes a back channel MSP430 Application UART that may be used
independently of a debug session. This allows the user to transfer serial data to a terminal window at a
fixed rate of 9600 bps with no flow control. Check the Device Manager for COM port assignment of the
MSP430 Application UART (for more details, see Section B.2).
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4.5 eZ430-Chronos Watch Schematics, Layout, BOM, and LCD

Figure 4-11. eZ430-Chronos-868 and -915 Watch, Schematics
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Figure 4-12. eZ430-Chronos-868 and -915 Watch, PCB Components on Top Layer
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Figure 4-13. eZ430-Chronos-868 and -915 Watch, Layout Top Layer (LCD Side)
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Figure 4-14. eZ430-Chronos-868 and -915 Watch, Layout 2nd Layer
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Figure 4-15. eZ430-Chronos-868 and -915 Watch, Layout 3rd Layer
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Figure 4-16. eZ430-Chronos-868 and -915 Watch, Layout Bottom Layer (Battery Side)
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Table 4-2. eZ430-Chronos-868 and -915 Watch, BOM List

Designator Value Tolerance Footprint Description Manufacturer

C1 47uF ±20% TAJ-A Capacitor SMD Tantalum, height max. 1.6mm

C2 47uF ±20% TAJ-A Capacitor SMD Tantalum, height max. 1.6mm

C3 47uF ±20% TAJ-A Capacitor SMD Tantalum, height max. 1.6mm

C4 4.7uF ±20%, X5R 603 Capacitor SMD

C5 470nF ±10%, X5R 402 Capacitor SMD

C6 100nF ±10%, X7R 402 Capacitor SMD

C7 100nF ±10%, X7R 402 Capacitor SMD

C8 15pF ±5%, COG/NP0 402 Capacitor SMD

C9 15pF ±5%, COG/NP0 402 Capacitor SMD

C10 10nF ±10%, X7R 402 Capacitor SMD

C11 2.2pF ±0.25pF, COG/NP0 402 Capacitor SMD

C12 10nF ±10%, X7R 402 Capacitor SMD

C13 220pF ±10%, COG/NP0 402 Capacitor SMD

C14 100nF ±10%, X7R 402 Capacitor SMD

C15 100nF ±10%, X7R 402 Capacitor SMD

C16 100nF ±10%, X7R 402 Capacitor SMD

C17 1.8pF ±0.1pF, COG/NP0 402 Capacitor SMD Johanson 500R07S1R8BV4

C18 0R ±5% 402 Resistor SMD

C19 N.A.

C20 100nF ±10%, X7R 402 Capacitor SMD

C21 100nF ±10%, X7R 402 Capacitor SMD

C22 2.2nF ±10%, X7R 402 Capacitor SMD

C26 470nF ±10%, X5R 402 Capacitor SMD

C27 470nF ±10%, X5R 402 Capacitor SMD

C28 100nF ±10%, X7R 402 Capacitor SMD

D1 1N4148 805 Diode SMD

D2 1N4148 805 Diode SMD

L1 12nH ±5% 402 Inductor Monolithic SMD Johanson L-07C12NJV4

L2 5.6nH ±0.3nH 402 Inductor Monolithic SMD Johanson L-07C5N6SV4

L3 N.A.

L4 0R ±5% 402 Resistor SMD

35mH,
L5 RDC<=250Ohm, ±10% Inductor Coil

IDC>=1mA

L6 100nH ±10% 402 Inductor Monolithic SMD

4mH,
L7 RDC<=100Ohm, ±10% Inductor Coil

IDC>=10mA

Female HeaderP1 Connector SMD e.g. MPE-Garry BL SMD 91-061.27mm

CUSTOM, solder PCB, 4 layers, 0.6 mmPCB1 stop black thick

BC846BW or Bipolar Transistor NPNQ1 SOT323BC847BW SMD

BC846BW or Bipolar Transistor NPNQ2 SOT323BC847BW SMD

BC846BW or Bipolar Transistor NPNQ3 SOT323BC847BW SMD

R2 47k ±5% 402 Resistor SMD

R3 56k ±1% 402 Resistor SMD

R4 47k ±5% 402 Resistor SMD

R5 47k ±5% 402 Resistor SMD

R7 10k ±5% 402 Resistor SMD

R8 10k ±5% 402 Resistor SMD

R9 10k ±5% 402 Resistor SMD
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Table 4-2. eZ430-Chronos-868 and -915 Watch, BOM List (continued)

Designator Value Tolerance Footprint Description Manufacturer

MCU with ISMU1 CC430F6137IRGC QFN64 TITransceiver

U2 0896BM15A0001 896MHz Balun Johanson

U3 CMA3000-D01 WLP Acceleration Sensor SPI VTI

U4 HKA5403Q-30 DIE EL Driver

U5 SCP1000-D11 Pressure Sensor I2C VTI

32.768kHz, 3.2 x 1.5Y1 CL=12.5pF, ±20ppm Crystal SMD Microcrystal CC7V-T1Amm2ESR<=80kOhm

26MHz, CL=10pF, 3.2 x 2.5Y2 ±10ppm Crystal SMD Epson TSX3225-X1E000021014300ESR<=40Ohm mm2
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Figure 4-17. eZ430-Chronos Watch, LCD Segment Map
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Figure 4-18. eZ430-Chronos Watch, LCD Pinout
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4.6 eZ430-Chronos Access Point Schematics, Layout and BOM

Figure 4-19. eZ430-Chronos-868 and -915 RF Access Point, Schematics
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Figure 4-20. eZ430-Chronos-868 and -915 RF Access Point, PCB Components on Top Layer
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Figure 4-21. eZ430-Chronos-868 and -915 RF Access Point, Layout Top Layer (LCD side)
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Figure 4-22. eZ430-Chronos-868 and -915 RF Access Point, Layout Bottom Layer
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Table 4-3. eZ430-Chronos-868 Access Point, BOM List

Designator Value Tolerance Footprint Description Manufacturer

C1 1.0uF +-10%, X5R 603 Capacitor SMD

C2 4.7uF +-10%, X5R 603 Capacitor SMD

C3 2.2uF +-10%, X5R 603 Capacitor SMD

C4 47pF +-10%, COG/NP0 402 Capacitor SMD

C5 47pF +-10%, COG/NP0 402 Capacitor SMD

C6 100nF +-10%, X7R 402 Capacitor SMD

C7 100nF +-10%, X7R 402 Capacitor SMD

C8 1.0uF +-10%, X5R 603 Capacitor SMD

C9 100nF +-10%, X7R 402 Capacitor SMD

C10 10nF +-10%, X7R 402 Capacitor SMD

C11 2.2pF +-0.25pF, COG/NP0 402 Capacitor SMD

C12 10nF +-10%, X7R 402 Capacitor SMD

C13 220pF +-10%, COG/NP0 402 Capacitor SMD

C14 22pF +-5%, COG/NP0 402 Capacitor SMD

C15 22pF +-5%, COG/NP0 402 Capacitor SMD

C16 1.8pF +-0.1pF, COG/NP0 402 Capacitor SMD Johanson 500R07S1R8BV4

C17 100pF +-10%, COG/NP0 402 Capacitor SMD

C18 N.A.

D1 green 603 LED SMD

E1 0868AT43A0020 Chip Antenna Johanson

Ferrite Bead 1k,L1 402 EMI Filter SMD e.g. TDK MMZ1005S102C1R, min. 100mA

L2 5.6nH +-0.3nH 402 Inductor Monolithic SMD Johanson L-07C5N6SV4

L3 8.2nH +-5% 402 Inductor Monolithic SMD Johanson L-07C8N2JV4

L4 15nH +-5% 402 Inductor Monolithic SMD Johanson L-07C15NJV4

P1 USB Type A USB Plug e.g. Lumberg 241007

CUSTOM, solder PCB, 2 layers, 0.8 mmPCB1 stop black thick

R1 2R +-5% 402 Resistor SMD

R2 33R +-5% 402 Resistor SMD

R3 33R +-5% 402 Resistor SMD

R4 1.5k +-5% 402 Resistor SMD

R5 56k +-1% 402 Resistor SMD

R6 270R +-5% 402 Resistor SMD

R7 0R +-5% 402 Resistor SMD

U1 TPS76933DBV SOT-23 Linear Regulator TI

U2 CC1111F32RSP QFN36 ISM Transceiver TI

U3 0896BM15A0001 896MHz Balun Johanson

48MHz, CL=16pF, 23.2 x 2.5Y1 +-10ppm Crystal SMD Epson TSX3225-X1E000021040300ESR<=40Ohm mm2
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Table 4-4. eZ430-Chronos-915 Access Point, BOM List

Designator Value Tolerance Footprint Description Manufacturer

C1 1.0uF +-10%, X5R 603 Capacitor SMD

C2 4.7uF +-10%, X5R 603 Capacitor SMD

C3 2.2uF +-10%, X5R 603 Capacitor SMD

C4 47pF +-10%, COG/NP0 402 Capacitor SMD

C5 47pF +-10%, COG/NP0 402 Capacitor SMD

C6 100nF +-10%, X7R 402 Capacitor SMD

C7 100nF +-10%, X7R 402 Capacitor SMD

C8 1.0uF +-10%, X5R 603 Capacitor SMD

C9 100nF +-10%, X7R 402 Capacitor SMD

C10 10nF +-10%, X7R 402 Capacitor SMD

C11 2.2pF +-0.25pF, COG/NP0 402 Capacitor SMD

C12 10nF +-10%, X7R 402 Capacitor SMD

C13 220pF +-10%, COG/NP0 402 Capacitor SMD

C14 22pF +-5%, COG/NP0 402 Capacitor SMD

C15 22pF +-5%, COG/NP0 402 Capacitor SMD

C16 1.8pF +-0.1pF, COG/NP0 402 Capacitor SMD Johanson 500R07S1R8BV4

C17 100pF +-10%, COG/NP0 402 Capacitor SMD

C18 N.A.

D1 green 603 LED SMD

E1 0915AT43A0026 Chip Antenna Johanson

Ferrite Bead 1k,L1 402 EMI Filter SMD e.g. TDK MMZ1005S102C1R, min. 100mA

L2 5.6nH +-0.3nH 402 Inductor Monolithic SMD Johanson L-07C5N6SV4

L3 5.6nH +-0.3nH 402 Inductor Monolithic SMD Johanson L-07C5N6SV4

L4 12nH +-5% 402 Inductor Monolithic SMD Johanson L-07C12NJV4

P1 USB Type A USB Plug e.g. Lumberg 241007

CUSTOM, solder PCB, 2 layers, 0.8 mmPCB1 stop black thick

R1 2R +-5% 402 Resistor SMD

R2 33R +-5% 402 Resistor SMD

R3 33R +-5% 402 Resistor SMD

R4 1.5k +-5% 402 Resistor SMD

R5 56k +-1% 402 Resistor SMD

R6 270R +-5% 402 Resistor SMD

R7 N.A.

U1 TPS76933DBV SOT-23 Linear Regulator TI

U2 CC1111F32RSP QFN36 ISM Transceiver TI

U3 0896BM15A0001 896MHz Balun Johanson

48MHz, CL=16pF, 23.2 x 2.5Y1 +-10ppm Crystal SMD Epson TSX3225-X1E000021040300ESR<=40Ohm mm2
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4.7 eZ430-Chronos Debugging Interface Schematics and Layout

Figure 4-23. eZ430-Chronos USB Debug Interface, Schematic
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Figure 4-24. eZ430-Chronos USB Debug Interface, Schematic
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Figure 4-25. eZ430-Chronos USB Debug Interface, PCB Components on Top Layer

Figure 4-26. eZ430-Chronos USB Debug Interface, PCB Components on Bottom Layer

Figure 4-27. eZ430-Chronos USB Debug Interface, Layout Top Layer

Figure 4-28. eZ430-Chronos USB Debug Interface, Layout Bottom Layer
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SLAU292–November 2009

Frequently Asked Questions

A.1 FAQs
1. My Chronos watch doesn't respond when I push buttons, instead it shows "Loct" in the LCD?

"Loct" on the 7-segment LCD stands for "lock" and indicated that the keylock is active. By holding "#"
and "DOWN" for 3 seconds simultaneously unlocks or locks the buttons. The LCDs shows "oPEn"
when the keylock is disabled.

2. Why doesn't my Chronos watch always respond when buttons are pushed?
If buttons are pushed slowly (i.e., held down too long), button pushes are ignored.

3. Why doesn't my Chronos respond when I try to push buttons in short intervals in PPT or ACC
mode?
Especially in PPT mode it is important to avoid bouncing of the buttons. Therefore, an artificial delay on
the receiver side is implemented. Button pushes are translated into keystrokes or mouse clicks only if
there is at least 0.5 seconds between two of them.

4. Is my Chronos waterproof?
Yes, it is 30m waterproof. This indicates that it resists splashes and rain. However, it can't be used
while taking a shower, swimming, diving, surfing, snorkeling or any other water sports. Set the watch
before exposing it to excessive water. Pressing the buttons in water or heavy rainstorms may cause
water to enter the watch.

5. The reported temperature is incorrect, how can I calibrate the sensor?
A temperature offset is stored in Flash, which is calibrated at production. If the offset is erased or is
incorrect, it can be changed to an appropriate level; see Section 3.2.1.3 for details.

6. The reported altitude is incorrect, why is that and how can I calibrate the sensor?
The altitude is determined from barometric pressure. Therefore, the altimeter needs to be re-calibrated
as the pressure changes with the weather. See Section 3.2.1.4 for details on how to calibrate the
altimeter. In addition, the altitude is a function of the temperature in addition to the barometric
pressure. Therefore, the watch needs to have ambient temperature, wearing it on the arm or close to
the body may cause inaccurate measurements.

7. Why is there a timeout for the altimeter?
The altimeter algorithm is implemented according to an application report from VTI. It is not optimized
for ultra-low current consumption. For enhanced battery life, the altimeter stops operation after one
hour. It can be re-activated by pushing the "UP" button.

8. How can TI sell the eZ430-Chronos for only US$49?
The eZ430-Chronos kits intended to be an attractive development kit, and is not intended to be a
consumer product. Texas Instruments and the partner companies are sponsoring components or
services in order to increase the accessibility of flexible and innovative development systems to a
broader audience. Consumer products usually retail for higher prices.

9. Why are the backchannel pins not connected on the Chronos PCB despite the fact that the
eZ430-Chronos debug interface supports the backchannel?
All pins of the CC430 were used for the LCD, buttons or sensors already.

10. Why is there no JTAG connector on the RF access point?
The access point is designed to be production ready and as small as possible. Therefore, no debug
connector is added. However, it may be reprogrammed by attaching a TI low power wireless debug
interface to the corresponding pads on the bottom side of the PCB, or using TI's CC1111EMK868-915.
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11. When I try to compile the source code with IAR KickStart, I get the following error:
Fatal Error[e89]: Too much object code produced (more than 0x4000 bytes) for this package
IAR KickStart currently has a 16KB code size limitation, and the project being compiled is larger than
16KB (0x4000 = 16384). Select the limited project version in the Workspace pull-down menu of the
IDE or use a full license of IAR. A 30-day evaluation version of IAR is available
fromhttp://supp.iar.com/Download/SW/?item=EW430-EVAL.

12. When I try to compile the source code with Code Composer Studio v4, I get the following
error:
error: output file "eZ430_chronos_ISM_xxx.out exceeds code size limit
Code Composer Studio v4 Core Edition is limited to 16kB of code size and the project being compiles
is larger than 16KB. Select the limited project version in the Build Property Configuration pull-down
menu of the IDE or use the Platinum Edition of CCS. A 30-day evaluation version is available
fromhttp://tiexpressdsp.com/index.php/Category:Code_Composer_Studio_v4

13. What is the range of the Chronos kit?
In free field distances of up to 100 m (328 ft) have been measured. The range in other conditions,
especially within buildings, is hard to predict. It also depends on the protocol stack that is used.

14. A button fell of the Chronos housing after I re-assembled it.
The buttons of the Chronos watch housing are held by small C-clips. If the metal strips for the buttons
of the watch module bent and stuck at the watch housing buttons, they could have removed the C-clip.
Open the watch, locate the C-clip, and re-assemble the button.

15. How do I know whether I have a 868-MHz or 915-MHz kit?
Each eZ430-Chronos has a sticker on the outside that includes the part number/frequency. The
watches are the same for both frequencies from a hardware perspective. The USB Access Points are
slightly different. The 868-MHz version has a 0-Ω resistor next to the antenna, and the 915-MHz
version does not.
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Appendix B
SLAU292–November 2009

Detailed Hardware Driver Installation Guide

Detailed instructions for the Windows driver installation of the Access Point and the Debug Interface. The
instructions are shown for Windows XP, but are similar in Windows Vista and Windows 7.

B.1 eZ430-Chronos RF Access Point
1. The eZ430-Chronos Access Point USB drivers are included in the eZ430-Chronos installer package. A

separate driver wizard window opens during installation as shown in Figure B-1. Continue by clicking
next. A Windows warning may appear as the driver is not certified. Accept the driver installation.

Figure B-1. Device Driver installation Wizard for the Access Point

2. The driver installation wizard shows if the driver is successfully installed (see Figure B-2)
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Figure B-2. Successful Driver Installation for Access Point

3. Insert the Access Point.
4. Windows detects the new hardware as TI CC1111 Low-Power RF to USB CDC Serial Port (see

Figure B-3).

Figure B-3. eZ430-Chronos Access Point Detection

5. Windows may open the Found New Hardware Wizard. If so, select No, not this time (see Figure B-4).
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Figure B-4. Windows Found New Hardware Wizard

6. Select Install the software automatically in next dialog (see Figure B-5).
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Figure B-5. Automatic Driver installation

7. A Windows warning appears as the driver is not certified. Click Continue Anyway (see Figure B-6). The
drivers are installed.
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Figure B-6. Windows Uncertified Driver Installation Warning

8. The Windows Device Manager lists the device TI CC1111 Low-Power RF to USB CDC Serial Port
(COMx) in Ports (COM & LPT) (see Figure B-7).
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Figure B-7. eZ430-Chronos Access Point in Windows Device Manager

B.2 eZ430-RF Debug Interface
1. Install an IDE of your choice (see section xxx) IDE, it contains the drivers for the debug interfaces
2. Connect the eZ430-RF USB Debug Interface to an USB port of the PC
3. Windows should now recognize the new hardware as an "MSP430 XXX x.xx.xx" (see Figure B-8). The

device name may be different from the one shown here.

Figure B-8. eZ430-RF Windows Driver Installation

4. The drivers are installed automatically without any user interaction.
5. The USB debug interface is installed and ready to use. The Windows Device Manager lists a new

entries for a Human Interface Device and the MSP430 Application UART (COMx) (see Figure B-9).
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Figure B-9. eZ430-RF in Windows Device Manager as HID and COM Port Devices
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specifications. Buyers acknowledge and agree that any such use of TI products which TI has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.
TI products are neither designed nor intended for use in automotive applications or environments unless the specific TI products are
designated by TI as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.
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